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What are AR Glasses

Merriam-Webster
Definition for AR

an enhanced version of reality
created by the use of technology to
overlay digital information on an
image of something being viewed
through a device (such as a
smartphone camera)

Apple Vision Pro AR glasses

J AR Glasses

AR glasses offer a hands-free experience of augmented reality &) y‘y’
(AR). These glasses serve as a tool for viewing and interacting

with AR, maybe eventually replacing phones, as can be seen in \\& ’\a/ y/
media. We can already see many companies investing in them . ”
N\ |/

for the future like apple and microsoft.
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Research Framework

What:

Why for me:
Why for

Everyone else:

Who:

An AR lens that lets you more closely connect to
the nature around you more intimately

This is what | wanted to research for 4th year.
General interest in AR subject and topic

To be able to identify different wildlife and
plantlife in nature to deepen our connection
with the environment

Anyone who wants to understand their
environment. With a phone and space to
download the app and with data or the ability
to connect to the internet
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Ethics, Accessibility and Intention / \

Ethics

o  Will scanning everything in public infringe on privacy
o How will this affect our connection with nature when
there is a screen between

Accessibility
o How will those with a disability be able to use it
(visually impaired, dyslexia, ect.)
o  Will every have an internet connection when in nature

Intention
o Toincrease the connection between people and the
wildlife around them
o To promote environmental awareness about invasive
or native plant types




Pro’s and Con’s

60% ——

Pro’s

Educational
Conservational
Tourism
Recreational

— 40%

)
Con’s
e Reliability
e Limitations
e Privacy




Micro
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Microlnteractions

Educational Sharing
Community Building
Environmental Activism

Example

Sam and Bernice decide to g0
hiking, to see who can flnd the
most unique species of ivy.

MicroAggressions

Generational Criticism
Technological Dependance
Nature Authenticity Doubt

Example

Mary Antoinette laughs at Jeff,
as their AR glasses bacteries dies
and they can no longer tell what

mushroom is poisonous




Different Applications

Spark Studios

Very easy to pick up
and learn. Lots of
community around it.

Unreal

To complicated and
hard for me to explore

g

Ar

Unity

Easy to use and lots of
variability.

Aero (Adobe)

To simple and not able
to fully adapt to what |
need




Using the GPT

» | You

how would someone go about making their own ar glasses

You

how come as soon as i open unity with the AR preset it gives me errors and asks me to enter safe
mode

You

oki finaly have what i think is a working setup of an AR scene in Unity, but when i export to my
phone that is in developer mode with a usb connection. it is just a black screen

You

hey. if i wanted unity to recognize a tree in AR. like recognize a species of tree without having a
picture of the exact tree... is it even possible?
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Makmg the Prototype Ng'

Image
recognition

| found a tutorial that
explained image
recognition and
replacement.
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Please don't judge how messy my desk is

Process



Wins and Losses

Wants

A Google cardboard style

AR glasses

Able to recognize a

specific type of plant or

tree

give a description

Appear after looking at an

object for a certain

amount of time

o Potentially with a

loading bar
showing it is
currently scanning

Wins

Has 2 displays to mimic
an AR display

Able to recognize an
image of a specific plant

Woes

Is blurry
Only recognize a specific
image of a plant, and not
the species
Never made/used a
google cardboard to hold
my phone in place
Forgot that | wanted it to
appear after a certain
time

o No loading bar




Conclusion

What | did:
e too much time researching on the wrong topics
o how to make QR codes
o make physical AR glasses
| o What program to use
- e tutorial about image tracking in Unity much later
Q% e explored several programs

What | wished | did:
e teaching software to recognize a tree
e finding a way to connect Google Lens to my
project
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Appendix Index

Initial
Inspiration

The main idea and steps
to achieve it

Making the
prototype

The final project and all the
problems along the way

02 |

04

Chat GPT &
Exploring

My handy assistant and
exploring AR

Resources/
Conclusion

Thank you for listening!
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Initial [nspiration

The main Idea and steps to achieve it




AR MINECRAFT

A multiplayer and fuﬂy interactive XR
world that fully combines a virtual

reality in an augmented setting.




Is it Emerging

For Me

This is definitely an emerging tech in my opinion.
Since it is rarely seen with the people around, or in
the everyday and isn't talked about much

For Others

Now while this is not common place in my life, that is not
to say that it isn't being explored. The concept of AR
glasses has been around for a long time, and you can
even see similar products like it in movies (like Iron Man's
Glasses). We also know that it is still a developing field
because of companies like apple trying to produce the
apple vision Pro hopefully by early next year.




f\i What to be worried for

Ethics Transparenc
If AR glasses were to become While wearing AR glasses, it should
commonplace, society would live with let you know when it is gathering

\
J

a screen between themselves and information, for instance it should let
everything they ever interact with you know if its looking for your hand
signals

Accessibility Responsibilicy

AR glasses should be accessible for AR glasses could be perceived the
everyone, whether they are visually same way our phones do, taking up
impaired or physically challenged. our entire existence until we are left
.. Developers should implement unable to function without them.
L/ﬁ; » thoughtful measures to ensure that There is also a Privacy concern the
ﬁ "~ individuals facing various disabilities same way a Google device might
& n easily use and benefit from this have. Where it is constantly listening
. ‘;'?Qtechnology for the key words of “hey google” it
7N

could be scanning everything in
/~ search of your activation movement
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O?, ChatGPT & Exploring

My handy assistant and exploring AR




Help
Viewport
User (Sharing) v
layer0
v

makeup

& makeup

Camera: Front | View: User (Sharing) Grid spacing: 100cm
Patch Editor

Add an experience type for the project Click the settings icon and Change Project Properties.




Which App To Use?

N
F

Aero

Working with Adobe Aero for my AR

app was both flexible and challenging.

While it offered a range of options,
getting the hang of it was a bit of a
learning curve, as it's quite different
from what I'm used to. Despite the
initial difficulty, it almost became my
top choice thanks to the abundance
of helpful information available for the
software.

=
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Unreal

Exploring Unreal for my AR app
presented its challenges. | had
trouble finding tutorials around the
subject and it left me navigating
during my first encounter with the
platform. Despite its evident
flexibility and myriad options, the
struggle stemmed from not having a
clear starting point to seamlessly
transition the project into an AR
application."
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Why Chat GPT

@ CchatGPT
Certainly! To manually install the required packages for Google Cardboard development in Unity,

follow these steps:

1. Native Camera1.3.7:
* Open the Unity Editor.
* Go to the menu bar and select “Window > Package Manager .
* In the Package Manager window, make sure you have the "Packages: In Project" tab
selected.
* Click on the "+ button at the top left corner and choose “Add package from git URL...".
* Enter the following Git URL for the Native Camera package: “https://github.com/Unity-
Technologies/NativeCamera.git .
* Click onthe "Add" button.
2. Google Cardboard XR Plugin for Unity 1.19.0:
* Similarly, in the Package Manager window, click on the “+" button.
* Enter the following Git URL for the Google Cardboard XR Plugin:
“https://github.com/googlevr/cardboard-xr-plugin.git#release/1.19.0 .
* Click onthe “Add" button.
3. Set up XR Plug-in Management:
* Goto "Edit > Project Settings > XR Plug-in Management'.
* Under the "Plug-in Providers" section, find “Cardboard XR Plugin" and make sure it's
selected for both iOS and Android.

After completing these steps, you should have the required packages installed for Google

Cardboard development in Unity, and the XR Plug-in Management should be set up correctly.
¥

Remember to save your scene and project after making these changes. If you encounter any

/4\\

I'm really bad at asking
questions, or | find that when |
can actually ask the question
that | need to ask, google gives
me the answers that | am not
looking for. So with Chat GPT |
can ask my questions without
fear of google not understanding
me, because | can just clarify
what | meant in the same google
search so to speak. | also find that
Chat GPT tends to walk me
through the answers. Especial for
this kind of project where | really
wanted to build my product, but
had no idea where to even start.




Making the
Prototype

The final project and all the
problems along the way




QR codes /ﬁ\\\

My original idea was actual to have a photo or 3d
print a mushroom or mini tree that had a QR
code on it. It was supposed to be that once | had
the lens set up, you could just scan the QR code
to display the image of information. This is
obviously not how it went because after a bit of Do not scan, dead website
research | found out that Unity has an image

tracking system. | then scrapped my idea

completely because this new image tracking

system was earlier to accomplish and it blended

in with the environment so much better and

smoother than a QR code would. | did find a way

to make QR codes and barcodes however

through Excel, and the few tutorials | found on

that should be in my resources list.

[=]
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?\;\ Making the Prototype

| found a tutorial that explained image
recognition and replacement. They used a
king of hearts and replaced it with a 2
spades, so | tried to mimic with dominos, it
did not work. | thought it was not detailed
enough so | used my unique book cover.
While that didn't work at first | found the
solution that had nothing to do with the
detail of the photo | choose, but rather the
scene it was exporting. | did not replace the
book cover, but placed a 3d object that was
off center but attached to the tracked

5 ) image.
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Please don't judge how
messy my desk is

Process

These are process images of how
only 1 screen worked at first, or how
when both worked it wouldn't scan

the image. And the final image
being fully scanned with 2 views.
This is what | struggled with the
most, but after talking with my
co-worker he described a way to
get the camera to export as a raw
image, and with that we can create
a canvas with each of those images
coving the full display, therefor
mimicking the AR view that |
wanted. | still however have no idea
why it is so blurry. | believe it has
something to do with how the
images might be stretched over
the canvas, or because of the
processing power it takes to display
and run 2 cameras at the same
time.

\
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:g.‘e@“ ‘?‘Everything that I had to download

1.

There was no lingerie “Cardboard XR Plugin” but there was a “Google ARCore XR plugin”
which | added instead. Spoiler, it was not the right package | need.
o What it was is that | was trying to use a VR camera in an AR setting
o | still needed the cardboard pluggin | think and | was abble to add it in package manager with this
“https://github.com/googlevr/cardboard-xr-plugin.git#release/1.19.0" but it still didnt work
o  Still didn't work because while | had GitHub Desktop installed Git is a completely different
application that | still needed (look to step 3)

| also added this Native Camera 1.3.7.
o By going to package manager and adding this
“https://github.com/Unity-Technologies/NativeCamera.git”
| had to Download Git and change its PATH (one of the scariest things I've done on my
PC also the below step by step is from Chat GPT which is kinda why | love it)
o  Add Git to the System PATH (Windows):
o  Goto "System Properties > Advanced > Environment Variables" on your computer.
o Under the "System variables" section, find the "Path" variable and click "Edit."
o Click "New" and add the path to the directory where Git is installed (e.g., C:\Program Files\Git\bin
and C:\Program Files\Git\cmnd).
o Click "OK" to close the dialogue.
Gradle Is something else | had to download
o Under "System Variables," find and select the Path variable, then click "Edit."
o Add a new entry that points to the bin directory of your Gradle installation. In your case, it should
be something like C:\Gradle\gradle-8.4\bin.
o Click "OK" to save the changes.



https://github.com/googlevr/cardboard-xr-plugin.git#release/1.19.0
https://github.com/Unity-Technologies/NativeCamera.git

Errors that came up

1. Allthe AR defaults, | had to change to XR since AR is no longer a

standalone option

o Android SDK Build-tools component is not found. Make sure all tools are
installed in the SDK manager.
UnityEditor.Modules.ModuleManager:InitializePlatformSupportModules
()

o Saving has no effect. Your class
'UnityEditor. XR.Simulation. XREnvironmentViewManager' is missing the
FilePathAttribute. Use this attribute to specify where to save your
ScriptableSingleton. Only call Save() and use this attribute if you want
your state to survive between sessions of Unity.
UnityEditor.XR.Simulation.XREnvironmentViewManager:OnDisable ()
(at./Library/PackageCache/com.unity.xr.arfoundation@5.1.0/Editor/Simul
ation/XREnvironmentViewManager.cs:169)

2.  lwas using the AR preset but | then had to download XV and VR
packages and then redownload the AR package because | kept
getting compiler errors before | even added anything to the scene

3. And of course all the previous things | had to download.

To be honest | am not sure if | am using all of the programmes s
that | have downloaded but now when | try to export it to my N \\ 2 ,//
laptop, | have tons of compiler errors. | can no longer work on N\ /)
it on my laptop, only from my PC. \ /

\ | £




Opuntia microdasys

(angel's-wings, bunny ears
cactus, bunny cactus or
polka-dot cactus)

A flowering species in the
cactus family Cactaceae

Native and endemic to neteral
and northern Mexico

Conservation status:
Least concern

{
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Cactus

| just used one of the
slides available from this
presentation and

exported it to Photoshop
to add the texts. It is based
on one of the cactus in the
IXD lab. And the rest of the
information | had gotten
from Wikipedia using
google lens.




What it is SUPPOSED to

| think some of these

| photos did not work

&  because while my
| notebookisa 2D flat

image, these cactuses are
fully 3D and Unity might
be having a hard time
scanning them.




Resources/Conclusion

Thank you for listening




The Final

Product

This is what the final AR
prototype looks like.




Conclusion

| think | spent too much time researching on the wrong topics. | certainly
don't have the luxury of hindsight. However, | spent a considerable

amount of time researching how to make QR codes, physical AR glasses,
or even just what program to use, only to realize later that most of it

wouldn't contribute to the project. | only found the tutorial about image
tracking in Unity much later in the project. | had also explored several

programs over multiple days, but | had gone back to using Unity which

was my first choice.

| am still very happy with the overall product, and | am grateful that |
looked into all of these programs because | learned a lot. However, |
recognize that | could have developed my project faster as well as spent
more time researching aspects | couldn't accomplish. For instance, not
2 relying on image tracking/recognition but instead teaching software to
\recogmze a tree, or finding a way to connect Google to my project and
utilize Google Lens.
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Resources

https:/www.youtube.com/watch?v=CwgOIl1JAyeY

https://aithub.com/tensorflow/models/blob/master/research/object_d

etection/g3doc/tf2_detection_zoo.md

https://youtu.be/BWO-7XaYi00Q?si=MrESUFvD1aQT--uS

https://youtu.be/DKYAAHY 0J42si=ZQZteOETKPAFKQb9

https://youtu.be/0_u-9nvkBrg?si=4PrN4bPtfm4glgKd

https://youtu.be/XKVIfLRSYPKk?si=yfOKOdzPOSkUc8zk

https://youtu.be/N2ioyWYtOAM?si=zpKUGgkOYmeGGfFb2

https://youtube.com/shorts/RmprTO9PT7Y?2si=mnLuyWQr3oHCICmP

https://youtu.be/lplazwXWg-k?si=9UkekpCQuUMKIUKGEP

https://youtu.be/4ZY760EIUc4?si=IOL83uEZNavB3gS;j

https://youtu.be/okBINahi-X0?si=zkw_BDacsFgrfxPQqg

https://Wwww.merriam-webster.com/dictionary/augmented%20reality



https://www.youtube.com/watch?v=CwgOl1JAyeY
https://github.com/tensorflow/models/blob/master/research/object_detection/g3doc/tf2_detection_zoo.md
https://github.com/tensorflow/models/blob/master/research/object_detection/g3doc/tf2_detection_zoo.md
https://youtu.be/BWO-7XgYi0Q?si=MrESUFvD1aQT--uS
https://youtu.be/DKyAAHY_oJ4?si=ZQZteOETKPAFKQb9
https://youtu.be/0_u-9nykBrg?si=4PrN4bPtfm4q1gKd
https://youtu.be/xKvffLRSyPk?si=yfQKOdzPOSkUc8zk
https://youtu.be/N2ioyWYt0AM?si=pKUGgk0YmeGGfFb2
https://youtube.com/shorts/RmprTQ9PT7Y?si=mnLuyWQr3oHCICmP
https://youtu.be/IpJqzwXWg-k?si=9UkekpCQumKJUK6P
https://youtu.be/4ZY760EIUc4?si=IOL83uEZNavB3gSj
https://youtu.be/pkB1Nahi-X0?si=kw_BDqcsFgrfxPQq
https://www.merriam-webster.com/dictionary/augmented%20reality
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Chat GPT initial prompts (heard I have to submit it this way as a source?)

hey what are some micro interactions and micro agressions that could occur if AR glasses were commmonplace and could be used to scan plants and
animals to identify their species

using raw image render and canvas, i was able too display 2 AR cameras at the same time, however when | export to my phone it only shows 1, how do |
fix this

hey new question. if i hand 2 AR cameras in my unity project, and wanted to display both at the same time, how could I?

hey im trying to make a mr scene in unity. i keep getting this message "CommandInvokationFailure: Gradle build failed.

C:\Program Files\Unity\Hub\Editor\2022.3.13f1\Editor\Data\PlaybackEngines\AndroidPlayer\OpenJDK\bin\java.exe -classpath "C:\Program
Files\Unity\Hub\Editor\2022.3.13f1\Editor\Data\PlaybackEngines\AndroidPlayer\Tools\gradle\lib\gradle-launcher-7.2 jar" org.gradle.launcher.GradleMain
"-Dorg.gradle.jvmargs=-Xmx4096m" "assembleRelease"..........

ok i need to Next Packages must be manually installed with Git & Unity Package Manager:

Native Camera 1.3.7.

Google Cardboard XR Plugin for Unity 1.19.0.

Edit > Project Settings > XR Plug-in Management > Select Cardboard XR Plugin under Plug-in Providers for both: iOS & Android.

Hey! | want to be able to create AR glasses in unity with a google carboard

ok please. | really need your help. i have followed this tutorial on youtube that allows Unity to recognize an image and place a prefab cube once it
recognizes the object. the problem however is that it displays like an normal AR app on my phone, but | want it to | want the screen on my phone to be
set up in a VR view (stereoscopic view). so my display split into 2 with one slightly offset. As if it was in VR. BUT | still need it to be able to scan my image.
what could the pros and cons be of having an ar lens that identifies the species of plants and wildlife you are looking at

i have a unity AR project. howerver, is there a way so that when it opens on my phone it opens in the VR format. (so sideways with 2 screens for each eye
so i can hold my phone up to my head. it does still need to be able to use the camera

hey. if i wanted unity to recognize a tree in AR. like recognize a species of tree without having a picture of the exact tree... is it even possible?

hey im trying to follow this tutorial online... is this code still up to date/accurate? "/ See https://youtu.be/gpag5bAjya8 for accompanying tutorial and
usage!

oki finaly have what i think is a working setup of an AR scene in Unity, but when i export to my phone that is in developer mode with a usb connection. it
is just a black screen

how come as soon as i open unity with the AR preset it gives me errors and asks me to enter safe mode

hey unity keeps giving me this error message "Collab] Collab service is deprecated and has been replaced with PlasticSCM"
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